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1. Introduction

The Configuration Software SWC5090 provides a PC user interface for D5000/D6000 series modules that allows the user

to:
[ )
[ )

Read and Write configuration parameters from and to the unit (via COM port);
Restore data to and from local hard drive for backup;

Monitor Input values (via COM port).

Record monitoring sessions and save data to file.

1.1 Obtaining the SWC5090

The SWC5090 is absolutely free-of-charge and is distributed in each CD included in PPC5092 adapter package.
Moreover, the most updated version can always be freely downloaded from www.gmintsrl.com

1.2 Configurable models

G.M. International models that can be configured via SWC5090 software are:

Smart Solenoid Drivers: D5293S, D5294S, D52958S.

Temperature Converters: D5072S, D5072D, D5273S, D6072S, D6072D, D6273S.
Resistance Repeaters: D5072S-087, D5072D-087.

Thermocouple/mV Repeaters: D5072S-096, D5072D-096.

Analog Input: D5212Q, D6212Q

Digital Input: D5231E, D6231E.

Digital Output: D5240T.

Analog Signal Converter and Trip Amplifiers: D5254S, D6254S.

Load Cell/Strain Gauge Converter: D5246S.

HART® Mux Modem: 5700.

1.3 Requirements

The Configuration Software has to be installed on a machine with the following minimum requirements:

Pentium class Processor 200MHz;

800x600 pixels screen resolution;

256 MB RAM,;

1 USB port;

“Microsoft Windows” operating system with latest updates installed;

Windows 7 and 8 users should set text size at 100% (Small) in the Display settings of the Control Panel (see
screenshot in Figure 1).



Control Panel Home < ¥ g
Make it easier to read what's on your screen

f text and other items on your screen by choosing one of these options. To
screen, use the Magnifier tool.

Adjust resolution You can cha

= ) Brarily enlarge )
[H Calibrate color

Change display settings

@ Senaller - 100% (default) Preview

Adjust ClearType text
Set custom text size (DPI)

@ Larger - 150%

See also
Personalization

Devices and Printers

Apply

c I Document code: ISM0154 Revision: 10
Gl o = oy Installation_and use of the SWC5090
20852 Villasanta MB - Italy Configuration Software Sheet 3 of 56
=] = |
@\\:jvh » Control Panel b All Control Panel rems b Display ~ | 42 |[ Search Control Panet ol
(7]

Figure 1: display text size settings screenshot.

Furthermore, the following items are required:
e PPC5092 (USB-to-MiniUSB Adapter) with correct drivers installed (See Section 8.1);
e MiniUSB cable (provided with PPC5092).

Figure 2: PPC5092 Adapter.

L -

Figure 3: Mini-USB cable included with PPC5092.

2. SWC5090 Main Window

At start-up, the SWC5090 Configuration Software loads a Main Window, which is the same for all modules. The Main

Window is basically a frame with a menu at the top and a bottom bar.

In case the module is already connected to the PC correctly, the SWC5090 detects it and asks the user if he wishes to
Read parameters from module directly. COM port is automatically set in the configuration file for future sessions.

Instead, if the module is not connected at startup, the user can:
e decide to work offline by selecting the desired model from the “Module” entry in the Menu
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e read offline parameters saved to file by going to “File -> Open file” entry in the Menu

If the module is connected after startup of the SWC5090, the user has to manually read parameters by pressing the
dedicated button on the top right of the screen.

2.1 Main Menu

E G.M. International - SWC5080 Configuration Software - D30725\De0725 - — >

File  Settings Module 7 Store to device Load from device

Figure 4: Menu.

The menu at the top of the Main Window (see Figure 4) is divided into the following entries:
e “File”

Open: load configuration data from local hard drive backup;

Save: save configuration data to the present local hard drive backup;

Save as...: save configuration data to a different local hard drive backup;

Print Preview: screen preview of the configuration report to be printed;

— Print: configuration report print on paper;

Exit: exit from the configuration software.

o “Settings”
— Serial

In the COM Port Setup window (see Figure 5) the user can choose the COM Port of the PPC5092 in the drop-
down menu at the top. The connection to the module can be tested by pressing the “Test Port COM#” button.

Finally the COM Port can be updated by pressing the “Update Com Port & Exit” button or left unchanged by
pressing the “Exit without changes” button.

COM Port Setup

COomMm1 w

Test Port COM1

Update Com Port & Bt

Exit without changes

Figure 5: COM Port Setup window.

— Modbus
In the Module Modbus Setup window (see Figure 6) the user can introduce the Modbus address of the module
(from 1 to 247), the Modbus Baud Rate (selectable among 4800, 9600, 19200, 38400, 57600 and 115200 bps)
and the Modbus Format (no parity 1 stop bit, even parity 1 stop bit, odd parity 1 stop bit).
The changes are saved by pressing the “Ok” button, while they are discarded by pressing “Cancel”. Note that
the “Store to device” button on the menu bar must be pressed to make the Modbus settings effective. Moreover,
the module must be power cycled.
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Figure 6: Modbus Setup window.

— Temperature Scale (only available with Temperature converters)

Choose between °C and °F. The setting is stored into the configuration file for future uses.

e “Module”

— Select Model: during off-line operations, select the module window among supported ones;

— Show Identification: show the instrument and option code, and the software and hardware release. Identification

is only available after that a read operation from module has been successfully completed.
— Load Factory Settings: loads default parameters to configurator screen, for the selected module.

° “f)”

— Show EULA: The End User License Agreement is displayed and a copy can be saved;
— Help: Opens this document in pdf format;
— About SWC5090: Shows the release of the current SWC5090 Configuration Software.

— In the Update Manager window (see Figure 7) the user can automatically check the “Running Version” against the
“Last released Version” from G.M. International database. The Configuration Software can be updated by
pressing the “Update” button or left unchanged by pressing the “Exit” button.

On the right of the menu, two quick buttons are available: “Load from device”, “Store to device”.

Update Manager >
Running Version 136
Last Released Version 1.36

The curmrent version is the latest available
Push button <bExit> to terminate

Exit

Figure 7: Update Manager window.

By pressing the first one, the configuration settings, the Modbus settings and the Tag currently stored in the Module are
read from the module and displayed. Since this operation overwrites the settings on the screen, the user is asked for

confirmation.
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The “Store to device” button allows the storage to the Module of the configuration settings, the Modbus settings and the
Tag, which are currently displayed on the Configuration window. By doing so, the previous settings saved on the Module
are overwritten.

Note that all configuration functions are available only when offline (Monitor or Data Logger are inactive).

In particular, the “Store to device” button is activated only when configuration data was successfully read from the
Module or loaded from a backup file.

2.2 Bottom Bar

lldle... | 2017 May 26 - 12:20:56
Figure 8: Bottom Bar.

The Bottom Bar (see Figure 8) includes a status bar, a progress bar that indicates that the operation is in progress,
and the current date & time.

3. Application Windows

The center of the SWC5090 Configuration Software window is filled with the Application Window, which is different for
each module. In the Application Window the user can read the field data, configure the data ranges and so on.

3.1 D5072S, D5072D, D5273S, D6072S, D6072D, D6273S (up to software revision 2)

D5072S, D5072D, D5273S, D6072S, D6072D, D6273S are Universal Converters and share the same screens, except for
the number of input, output and alarm channels.

The Application Window user interface is organized into the following areas:
e Configuration
— Input
— Output
— Alarm
e Monitor
e Data Logger
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3.1.1  Configuration
3.1.1.1 Input
Bl G.M. International - SWC5080 Configuration Software - D30720\D6072D - = x
File  Settings | Module | 7 Store to device Load from device
i Corfigurelion | Montor  Data Logger
Input  Qutput  Alam
Input 1 Input 2
Sensor Connection TC i Sensor Connection e v
Sensor Type TCJ ~| | Open Sensor Type TCJ ~ | | Open
Downscale {TC) Downscale ()
Upscale (°C) Upscale ('C)
Cold Junction Source e - Cold Junction Source e -
Cold Junction Reference {C) Cold Junction Reference ('C)
Integration Speed sow | 375ms Integration Speed sow v 375ms
Mains Frequency 50 Hz Offset (V) El
Cffset {1V} ljl Muttiplier
[Data Editing 2017 May 26 - 12:2%:59
Figure 9: D5072D / D6072D Input configuration screen.
INPUT
Sensor Connection:
e TC
e RTD
e Potentiometer
e Voltage

e Resistance

Sensor Type: input sensor type (see list in section “Input specifications”)
possibility of configuring a completely customized input curve (TC/RTD)

Wires: 2, 3, 4 wires selection for RTD/Resistance inputs
Downscale: input value of measuring range corresponding to defined low output value
Upscale: input value of measuring range corresponding to defined high output value
Cold Junction Source: reference junction compensation type (thermocouple only)

e Automatic via internal compensator (1 for each channel)

e Fixed programmable temperature compensation at fixed temperature

e Other Input remote compensation using RTD on remaining channel

Cold Junction Reference: fixed temperature compensation value (Cold Junction type Fixed only), range from -60 to
+100 °C.

Integration speed:

e Slow 250 ms (mV/TC,2 wire RTD); 375 ms (Pot.), 500 ms (3,4 wire RTD)

e Fast 50 ms (mV/TC,2 wire RTD); 75 ms (Pot.), 100 ms (3,4 wire RTD)
Mains Frequency:

e 50Hz

e 60Hz onlyavailable with fast integration speed

Offset: value to be added/subtracted to input (uV or mQ depending on input sensor)
Multiplier: input multiplication value
Tag: 16 alphanumerical characters

Note: Downscale and Upscale settings should follow Minimum Span requirements stated in the data sheet, in order to
avoid negative impacts on Output resolution.
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3.1.1.2 Output

OUTPUT
Function:

Overrange: analog output downscale in overrange condition (range 0 to 24 mA)

Input 1
Input 2
Input 1 + 2
Input 1 -2

Min(Input 1, Input 2)
Max(Input 1, Input 2)

0-20 mA Sink
4-20 mA Sink
Custom Sink

0-20 mA Source
4-20 mA Source

Custom Source

E G.M. International - SWC5090 Configuration Software - D3072D4DE072D -

File  Settings Module 7

Store to device

= X

Load from device

Input  Output  Mam

Qutput 1
Function

Type

Downscale (uh)
Upscale (wA)
Under Range (uA)

Over Range (uA)
Fault Output Value (ud) 22000

Configurstion ' Monitor Data Logger

Input 1 ~

4-20mA Source ¥

L

Fault in case of

Bumout

[ Intemal Fault

[ Sensor Out Of Range

[ Output Saturation

[ Medule Temperature Out Of Range

Qutput 2
Function Input 2

Type 4-20mA Source

Downscale (uh)
Upscale (wA)
Under Range (uA)

Over Range (#)
Fault Output Value (ud) 22000

<EEs

Fault in case of
Bumout
[ intemal Fault
[[] Sensor Out Of Range
[ Output Saturation

~

~

[ Module Temperaturs Out Of Range

|Data Editing

2017 May 26 - 12:37:38

Figure 10: D5072D / D6072D Output configuration screen.

analog output represents input of first channel
analog output represents input of second channel

analog output represents the sum of the two input channels
analog output represents the subtraction of the two input ch.

All Output parameters are fully customizable

All Output parameters are fully customizable
Downscale: analog output downscale in normal working condition (range 0 to 24 mA)
Upscale: analog output downscale in normal working condition (range 0 to 24 mA)
Underrange: analog output downscale in underrange condition (range 0 to 24 mA)

analog output represents the lower of the two input ch.
analog output represents the higher of the two input ch.

Fault Output Value: analog output value in case of fault condition (range 0 to 24 mA)
Fault in case of: analog output is forced to “Fault Output Value” in case of:
input sensor interruption

Burnout
Internal fault

Sensor out of range

Output Saturation

Module Temp. Out of range

module internal fault

input sensor out of configured input range
output is below Underrange or above Overrange
internal module temp. under or over specified module operating temp. limits
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3.1.1.3 Alarm
El G.M. International - SWC5090 Configuration Software - D507200D6072D - = % Z .M. Intemational - SWC5090 Configuration Software - D3ZT35\D62T35 - - X
File Settings Module 7 Store to device Load from device Fie Settings Module 7 Store to device Loadfrom device
Configurstion. Monitor Dt Logger Configuition  Montor Data Logger
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Off Delay 5) [ ] Off Delay s} fe ]

In case of Faull
In case of Fault GoOn ~ In case of Faul Go On ~
Fauits
Fauhs Fauts
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Figure 11: D5072D/D6072D (on the left) and D5273S/D6273S (on the right) alarm configuration screen.

ALARM
Type:
e None alarm is disabled
e Low alarm is triggered when source descends below “Low Set”
e LowLock alarm is inhibited until source ascends over “Low Set”
and then, it behaves as a standard “Low” configuration
e High alarm is triggered when source ascends over “High Set”
e HighLock alarm is inhibited until source descends below “High Set”
and then, it behaves as a standard “High” configuration
e Window alarm is triggered below “Low Set” and above “High Set”
e Fault Repeater alarm output reflects selected (one or more) Fault status
Source: reference value for alarm triggering
e Input1 input of first channel
e Input2 input of second channel
e Input1+2 sum of the two input channels
e Input1-2 subtraction of the two input channels
e Min(lnput 1, Input 2) lower of the two input channels
e Max(Input 1, Input 2) higher of the two input channels
Condition:
e NE alarm output is normally energized when deactivated
e ND alarm output is normally de-energized when deactivated
Low Set: source value at which the alarm is triggered (in Low, LowLock, Window)
Low Hysteresys: triggered Low alarm deactivates when source value reaches

Low Set + Low Hysteresys (0-500 °C, 0-50 mV, 0-50 %)
High Set: source value at which the alarm is triggered (in High, HighLock, Window)
High Hysteresys: triggered High alarm deactivates when source value reaches
High Set - High Hysteresys (0-500 °C, 0-50 mV, 0-50 %)
On Delay: time for which the source variable has to be in alarm condition before the alarm output is triggered,;
configurable from 0 to 1000 seconds in steps of 100 ms
Off Delay: time for which the source variable has to be in normal condition before the alarm output is deactivated,;
configurable from 0 to 1000 seconds in steps of 100 ms
In case of fault:
e Ignore alarm is not affected
e Lock status alarm remains in the same status as it was before Fault occurred
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e GoOn alarm is triggered,
e Go Off alarm is deactivated

Faults: if “Type” is set to “Fault repeater” select which faults will be repeated by alarm output; if “In case of fault’ is
different from “Ignore”, select which faults should influence alarm output behaviour.

3.1.2 Monitor
he SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

Bl G.M. International - SWC5090 Configuration Software - D52735\D62735 - = x

File  Settings Module 7 Store to device Load from device

Corfiguration { Moriior | Data Logger
Channel 1 Graph

Aam Stat
Sensor Temperature (') am =iatue O
Alarm A
Cold Junction Temperature (°C) =i
Alam B
Theoretical Otput (u&) i

Fautts

Bumout Sensor Out Of Range

[ out 1

Intemal Fault Module Temperaturs Out OF Range e
Output Saturation

D52735D62735 graph

[Data Editing [ 2017 May 26 - 13:54:31
Figure 12: D5273S/D6273S Monitor screen.

The display shows Input and Theoretical Output values, fault and alarm status and a graph of chosen variable.

3.1.21 Input

Input variable is shown as it is detected by the module, after having applied configured calculations (Offset, Multiplier) and
conversions.

Cold Junction Temperature shows the value of the internal Cold Junction; this value will influence the Output measure
when Cold Junction configuration is set to “Automatic”.

3.1.2.2 Output
This value represents the theoretical output. During certain conditions, this value may differ from the measured value at
output terminal blocks.

3.1.2.3 Alarm status
Alarm status is represented by a LED, which is RED when activated.
The LED status reflects the status of the Alarm exactly as configured.

3.1.2.4 Faults
Each Fault status is represented by a LED, which is RED when activated.
Note that the LED status does not take into account the current module configuration, therefore it only indicates the
existence of the fault condition, independently from any configured behavior in case of fault.
3.1.2.5 Graph
The graph can show only one variable that must be chosen from the checkboxes above.

3.1.3 DataLogger
The SWCS5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
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Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.

Sl G.M. International - SWC5030 Configuration Software - DS2735\D62735 - = x
File Settings Module 7 Store to device. Load from device

Corfiguration  Monitor  Diata Logger

Parameters Setup

[Data Editing [ 2017 Moy 25- 135701
Figure 13: Data Logger screen.

3.2 D5072S, D5072D, D6072S, D6072D (from software revision 3)

D5072S, D5072D, D6072S, D6072D are Universal Converters and share the same screens, except for the number of
input, output and alarm channels.

The Application Window user interface is organized into the following areas:
e Configuration
— Input
— Output
— Alarm
e Monitor
e Data Logger
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3.21 Configuration

3.21.1 Input
E G.M. International - SWC5090 Configuration Software - D5072D\D&0720 - = x
File  Settings Module 7?7 Load from device
Configuration  Moritor Data Logger
Input  Output  Alam
Input 1 Input 2
Sensor family Tc ~ Sensor family Tc bt
Sensor connection 2 wires e Sensor connection 2wires o
Sensor Type Themocouple J ~ Sensor Type Thermocouple J ~
Bumout Active ~ Bumout Active v
Cold Junction Source Intemal ~ Cold Junction Source Irtemal 5
Cold Junction Reference ool [Tl Cold Junction Reference 00| ['T]
Cable resistance 0.00 [ Cable resistance 000 [
Muliplier 0 Multiplier 0
Tag Channel1 Tag Channel2
Common parameters
Integration Speed | Slow  ~
Open custom table
Callendar-Van Dusen
[idle... 2018 Mar 26 - 09:25:08
Figure 14: D5072D / D6072D Input configuration screen.
Sensor family:
e TC
e RTD
e Voltage

e Resistance
e Potentiometer
Sensor Type: input sensor type (see list in section “Input specifications”)
possibility of configuring a completely customized input curve (TC/RTD)
Sensor connection: 2, 3, 4 wires selection for RTD/Resistance inputs
2 wires or External compensator selection for TC
3 wires selection for potentiometer
Downscale: input value of measuring range corresponding to defined low output value
Upscale: input value of measuring range corresponding to defined high output value
Cold Junction Source: reference junction compensation type (thermocouple only)

e Automatic via internal compensator (1 for each channel)
o Fixed programmable temperature compensation at fixed temperature
e Other remote compensation using RTD on remaining channel

Cold Junction Reference: fixed temperature compensation value (Cold Junction type Fixed only), range from
-60 to +100 °C.

Cable resistance: available only for RTD and resistance sensors. Configurable from 0 to 50 Q
External compensator: compensation using RTD, Callendar van dusen or custom curve.
Integration speed:

e Slow

o Fast
Multiplier: input multiplication value
Tag: 16 alphanumerical characters

Note: Downscale and Upscale settings should follow Minimum Span requirements stated in the data sheet, in order to
avoid negative impacts on Output resolution.
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3.21.2 Output

E G.M. International - SWC5090 Configuration Software - D5072D\D60720 - = X
File  Settings Module 7 Store to device Load from device
Configuration  Maritor  Data Logger
Input  Output  Alam
Output1 Qutput2
Function Temp1 ~ Function Temp1 v
Drive Source ~ Drive Source ~
Type 4-20mA Low ~ Type 4-20mA Low gt
Downscale : Al [Tl Downscale [wA] [Tl
Upscale : Al 10000 1oy Upscale [ 10009] )
Under range [e4) Under range : [n4)
Overrange : Al Overrange [uA]
Faul output value © Al Faut output value : 4]
Damping factor [ 9u Damping factor [ dm
Fault Fault
Bumout Bumout
[ Intemal fautt [ Intemal fautt
[] Celd junction [] Cold junction
Cable resistance Cable resistance
[ Sensor out of specication [ Sensor ot of spectication
[] Out saturation [ Out saturation
[idle... 2018 Mar 26 - 09:28:51

Figure 15: D5072D / D6072D Output configuration screen.

OUTPUT
Function:
e Temp1 analog output represents input of first channel
e Temp2 analog output represents input of second channel
o Temp1-2 analog output represents the subtraction of the two input channels
o Temp2-1 analog output represents the subtraction of the two input channels
e Temp mean represents the inputs mean value.
e  Minimum analog output represents the lower of the two input channels
e Maximum) analog output represents the higher of the two input channels

¢ Redundancy When both sensors are available (no burnout condition) the input value represents the mean
value of inputs. In case of one of them go on burnout condition, the input value represents the only working sensor.

e Value 1 analog output represents input of first channel (Not available only for TC\RTD sensors)

e Value 2 analog output represents input of second channel (Not available only for TC\RTD sensors)
Drive: Source, Sink mode.
Type:

e 4-20 mA Low
e 4-20 mA High
e 0-20mA High
e 4-20 mA NE43 Low, NAMUR RECOMMENDATION
e 4-20 mA NE43 High, NAMUR RECOMMENDATION

e Custom Scale: all Output parameters are fully customizable
Damping factor: causes conventional single-pole low pass filtering which is similar to an R-C network. Although high
damping values will greatly suppress noise and make the output signal stable, it causes a slow response time.

Downscale: analog output downscale in normal working condition (range 0 to 24 mA)
Upscale: analog output downscale in normal working condition (range 0 to 24 mA)
Underrange: analog output downscale in underrange condition (range 0 to 24 mA)
Overrange: analog output downscale in overrange condition (range 0 to 24 mA)
Fault Output Value: analog output value in case of fault condition (range 0 to 24 mA)
Fault in case of: analog output is forced to “Fault Output Value” in case of:

e Burnout input sensor interruption
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Internal fault
Cold junction

Cable resistance
Sensor out of range

module internal fault

when resistance value is higher than 50 Q
input sensor out of configured input range

e Output Saturation output is below Underrange or above Overrange
e Module Temp. Out of range internal module temp. under or over specified module operating temp. limits
3.21.3 Alarm
E G.M. International - SWC5090 Configuration Software - D5072D\D6072D - = X
File  Settings Module 7 Store to device Load from device
Configuration  Monitor  Data Logger
Input  Output { Alarm |
Alam2
Type None v
Temp1
Open
[Tl
Il
[Tl
Il
ls]
ksl
Ignore
Bumout
Intemal fault
Cold junction
Cable resistance
Sensor out of specification
Out saturation
[idle... [ 2018 Mar26- 08:32:37
Figure 16: D5072D/D6072D alarm configuration screen.
ALARM
Type:
e None alarm is disabled
e Low alarm is triggered when source descends below “Low Set”
¢ High alarm is triggered when source ascends over “High Set”
e Window alarm is triggered below “Low Set” and above “High Set”
e Fault Repeater alarm output reflects selected (one or more) Fault status
Function:
e Temp1 analog output represents input of first channel
e Temp?2 analog output represents input of second channel
e Temp1-2 analog output represents the subtraction of the two input channels
e Temp2-1 analog output represents the subtraction of the two input channels
e Temp mean represents the inputs mean value.
e  Minimum analog output represents the lower of the two input channels
e Maximum) analog output represents the higher of the two input channels
e Redundancy When both sensors are available (no burnout condition) the input value represents the mean
value of inputs. In case of one of them go on burnout condition, the input value represents the only working sensor.
e Value 1 analog output represents input of first channel (Not available only for TC\RTD sensors)
e Value 2 analog output represents input of second channel (Not available only for TC\RTD sensors)

Alarm lock: alarm is inhibited until source ascends over “Low Set or descends below “High Set, and then it behaves as a
standard “Low” or “High” configuration

Contact position in alarm:

Open

alarm output is normally Open in case of alarm condition
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e Closed alarm output is normally Closed in case of alarm condition
Low Set: source value at which the alarm is triggered (in Low, LowLock, Window)

Low Hysteresys: triggered Low alarm deactivates when source value reaches Low Set + Low Hysteresys
High Set: source value at which the alarm is triggered (in High, HighLock, Window)
High Hysteresys: triggered High alarm deactivates when source value reaches High Set - High Hysteresys

On Delay: time for which the source variable has to be in alarm condition before the alarm output is triggered;
configurable from 0 to 1000 seconds in steps of 100 ms
Off Delay: time for which the source variable has to be in normal condition before the alarm output is deactivated;
configurable from 0 to 1000 seconds in steps of 100 ms

In case of fault:

e Ignore alarm is not affected
e Lock alarm remains in the same status as it was before Fault occurred
e Alarm active alarm is triggered,

e Alarminactive alarm is deactivated
Faults: if “Type” is set to “Fault repeater” select which faults will be repeated by alarm output; if “In case of fault” is
different from “Ignore”, select which faults should influence alarm output behaviour.

3.2.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

El G.M. International - SWC3090 Configuration Software - D5072D0DE072D - = X

File  Settings Module ? Store to device Load from device

Configuration Monitor  Data Logger
Channel 1 Channel 2

Sensor working temperature Sensor working temperature

Reset values Reset values
Faults Faults
Open / bumout Open / bumout

Cold junction Cold junction

Sensor out of specification Sensor out of specification
Qutput saturation CQutput saturation

Cumulative faults Aam status
Intemal / hardware fault Alam B

Configuration fault

Start

[idle... [ 2018 Mar 26- 09:38:49
Figure 17: D5072D/D6072D Monitor screen.

The display shows Input and Theoretical Output values, fault and alarm status and a graph of chosen variable.

3.2.21 Input
Input variable is shown as it is detected by the module, after having applied configured calculations (Multiplier) and
conversions.

3.2.2.2 Output
This value represents the theoretical output. During certain conditions, this value may differ from the measured value at
output terminal blocks.
3.2.2.3 Alarm status
Alarm status is represented by a LED, which is RED when activated.
The LED status reflects the status of the Alarm exactly as configured.
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3.2.24 Faults

Each Fault status is represented by a LED, which is RED when activated.

Note that the LED status does not take into account the current module configuration, therefore it only indicates the
existence of the fault condition, independently from any configured behavior in case of fault.

3.2.3 DataLogger

The SWCS5090 can monitor and record data from the module at constant configurable time intervals.

By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.

I G.M. Internstional - SWC5030 Cnfiguration Software - D3Z735\D62735 - - X
File Settings Module 7

Store to device. Load from device

Parameters Setup

Daye 0

Hours 0

Minutes 1

Scan Rate 5] (05

Corfiguration  Monitor  Data Logger

Clear

[Data Editing

[ 2077 May 26 - 13:57:01

Figure 18: Data Logger screen.

3.3 D5072S-087, D5072D-087(from software revision 3)

D5072S-087, D5072D-087 are Universal Repeaters and share the same screens, except for the number of input, output

and alarm channels.

The Application Window user interface is organized into the following areas:

e Configuration
— Input/ Output

e Monitor

e Data Logger
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3.3.1  Configuration

3.3.1.1  Input
z G.M. International - SWC5090 Configuration Software - D50T2D-087 - = x
File Settings Module 7 Load from device
Configuraton  Montor  Data Logger
rput' Output
Input 1 Input 2
Sensor connection Iwires ~ Sensor connection Jwires hd
In'Out function Linear standard - In'Out function Linear standard v
Bumout Active w Bumout Active
Muipher 1 Multipher 1
Cable resistance  [0] Cable resstance  [1]
Tag Channel1 Tag Channel 2
Output1 Output2
Integration Speed | Slow v Integration Speed |Sow v
Fauk Fait
[ ntemal faut [ rtemal fau
B Bumout B4 Bumeut
Input common parameters Output duplication
Open custom table
Itegration Speed | Slow v [ Active/inactive
fidte... [ 2018 Jun 20 - 134241
Figure 19: D5072D-087 Input / Output configuration screen.
INPUT
Sensor connection: 2, 3, 4 wires selection
Input / Output function:

e Linear standard: output reflects the input signal (standard range)
e Linear extended: output reflects the input signal (extended range)

e Custom: possibility of configuring a completely customized input curve
Burnout:

e Active: when selected burnout fault condition is triggered

e Inactive: when selected burnout fault condition is not triggered

Multiplier: input multiplication value

Cable resistance: configurable from 0 to 50 Q
Tag: 16 alphanumerical characters

Output Integration speed:

e Slow

o Fast
Fault condition:

e Internal fault: module internal fault

e Burnout: input sensor interruption
Input Integration speed:

e Slow

e Fast

Output duplication:
e Active/inactive: when selected, it disables Input 2 and Output 2 configuration

3.3.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.
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E G.M. International - SWC5090 Configuration Software - D50720-087 - = x
File  Settings Module 7 Store to device Load from device
Configuration  Menitor — Data Logger
Channel 1 Channel 2
Field values Field values
Head 1 measured valus (0] Head ? measured value 9]
Theoretical output 1 Theoretical output 2]
Faults Faults
Open / bumout Open / bumout
Cumulative faults
Intemal / hardware fault
Configuration fault
Start
[idle... 2018 Apr 13 - 14:17:00

Figure 20: D5072D-087 Monitor screen.

The display shows Field values and Fault status.

3.3.2.1 Field values
Field values represent heads measured values and theoretical outputs.

3.3.2.2 Faults
Each Fault status is represented by a LED, which is RED when activated.

Note that the LED status does not take into account the current module configuration, therefore it only indicates the
existence of the fault condition, independently from any configured behavior in case of fault.

3.3.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.

E G.M. International - SWC3090 Configuration Software - D30720-087 - . X

File  Settings Module 7 Store to device Load from device

Corfiguration  Moritor  Data Logger

Parameters Setup

Days 0 >

Hours U] v

Minutes ] v

Scan Rate [s] 0.5 ~

Start Clear

[idle... 2018 Apr 13 - 14:22:29
Figure 21: Data Logger screen.
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3.4 D5072S-096, D5072D-096

D5072S-096, D5072D-096 are Universal Repeaters and share the same screens, except for the number of input, output
and alarm channels.

The Application Window user interface is organized into the following areas:
e Configuration
— Input / Output
e Monitor
e Data Logger

3.41 Configuration

3.41.1 Input
B G.M. Intemational - SWC5020 Configuration Software - D50720-086 - = X
File Settings Module 7 Load from device
Configuration  Monitor Data Logger
Input \Output
Input 1 Input 2
In\Out fungtion Linear i In\Out fungtion Linear S
Bumout Active ¥ Bumout Active ¥
Cold Junction Source Intemal Cold Junction Source Intemal
Cold Junction Reference ['C] 0.0 Cold Junction Reference ['C] 0.0
Output Output2
Fault Fault
[ Intemal fautt [ Intemal fautt
Bumout Bumout
Input common parameters
Open custom table
Integration Speed | Slow
idle.. 2018 Apr 13- 142707
Figure 22: D5072D-096 Input / Output configuration screen.
INPUT
Input / Output function:
e Linear: output reflects the input signal
e Custom: possibility of configuring a completely customized input curve(Thermocouple)
e Thermocouple: input sensor type(see list in section “Input specifications”)
Burnout

e Active: when selected burnout fault condition is triggered
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e Inactive: when selected burnout fault condition is not triggered
Cold junction source:
e Internal: via internal compensator (1 for each channel)
e External: programmable temperature compensation at fixed temperature

Cold Junction Reference: fixed temperature compensation value (Cold Junction type Fixed only), range from
-60 to +100 °C.

Tag: 16 alphanumerical characters
Integration speed:
e Slow
e Fast
Fault condition:
e Internal fault: module internal fault
e Burout: input sensor interruption

3.4.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

E G.M. International - SWC5090 Configuration Software - D5072D-036 - = x
File  Settings Module 7 Store to device Load from device
Configuration  Monitor  Data Logger
Channel 1 Channel 2
Field values Field values
Head 1 measured valus mV] Head 2 measured value V]
Theoretical output mv] Theoretical output [mVv]
Faults Fauits
Open / bumout Open / bumout
Cumulative faults
Intemal / hardware fault
Configuration fault
Start
[idle... 2018 Apr 13 - 14:30:39

Figure 23: D5072D-096 Monitor screen.

The display shows Field values and Fault status.

3.4.2.1 Field values
Field values represent heads measured values and theoretical outputs.

3.4.2.2 Faults
Each Fault status is represented by a LED, which is RED when activated.

Note that the LED status does not take into account the current module configuration, therefore it only indicates the
existence of the fault condition, independently from any configured behavior in case of fault.

3.4.3 DataLogger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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FE G.M. International - SWC3090 Configuration Software - D50720-096 - - pd
File  Settings Module 7 Store to device Load from device
Configuration  Monitor Data Logger
Parameters Setup
Days 0 v
Hours 0 i
Minutes 0 ~
Scan Rate 5] |05 ~
Start Clear
[idle... [ 2012 Apr 13- 143145

Figure 24: Data Logger screen.

3.5 D5231E/D6231E

D5231E is an intrinsically safe eight channel Switch/Proximity detector repeater interface.
Modbus RTU RS-485 output is available on Bus connector.
The Application Window user interface is organized into the following areas:

e Configuration

e Monitor

e Data Logger
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3.5.1 Configuration

HE G.M. Intemational - SWC5090 Configuration Scftware - D5231E\DE231E - - x 5E G.M. Intemationl - SWC5090 Configuration Software - D5231E\DE231E - - x
File Settings Module 7 Sore to device Load from device File Settings Module 7 Store o device Load from davice
Configuration  Moritor Data Logger Corfigurafion  Moritor Data Logger
Irouls  Outputs frputs  Outputs

inputs Tags Outputs N .
2 = | 1 & souce Contactpastion  Contact position
Input 1 [Progmity | Faubonbus [ Tagl [l e it
Outout 1 [Input 1 v Faull repeater Open ~ Cosed v
‘ | -0 l condi
Input2 [Proxmity | Faukonbus [] Tag2 [2 O Opf, M) St
Outout 2 |Inpet 2 v _ Fault repester Open + Cosed v
— -Open i nemal condiion.
Input3 |Promity  ~ Faukonbus [] Tag3 3 -Closed in fauk  condiion
Qutput 3 | Cumulative fault Open Oosed Cumulative fault :
- o S T W - ..  -Ovennnoma condbon
Input 4 [Dy Contact | Fauit on bus Tag4  [4 | ki o k. nd w5 (i€ []In % - Closed nfaut condtion.
Qutput 4 | Inpet 4 v Open ~
Input5 Dry Contact | Faut on bus Tags |5
Output 5 | Input 5 ~ Open
Input 6 {DryContact ~ | Faukonbus Tagb
. - Quiput § | Inpet 6 v Open ~
Input7 Dy Contact | Faut on bus Tag7 P = e
Input & | Dy Contact | Faut on bus Tagd |3 Output 8 | Logical Function Opan + Open
AND v Ort Okz Ok3 Ok4 Oks One On7 Oke
[Data Editing 7 [ 2017 May 20- 102314 [Data Editing 7 [ 2017 May 30- 102626

Figure 25: D5231E / D6231E input (on the left) and output (on the right) configuration screen.

Configuration parameters can be read and written from the module or from saved file. It is also possible to reset the
module configuration to factory default settings. A report sheet containing complete configuration can be printed.

INPUTS 1 to 8:
e Sensor Type:
—  Proximity
— Dry Contact

Note: To enable line diagnostic on Voltage free contacts, follow instructions in Section “Operation” of Instruction Manual
ISM0172 and configure sensor as “Proximity”.

TAGS 1 to 8:
16 alphanumerical characters
OUTPUTS 1 to 8:

e Source:

— Input1 Output represents Input 1

— Input 2 Output represents Input 2

— Input3 Output represents Input 3

— Input4 Output represents Input 4

— Input5 Output represents Input 5

— Input6 Output represents Input 6

— Input?7 Output represents Input 7

— Input8 Output represents Input 8

— Logical function Output represents AND/OR function of selected inputs

— Cumulative fault: Output represents OR function of selected inputs fault conditions
e Contact: normal condition of output contact

— Open

— Closed (for SIL applications)
¢ In case of fault:
— lIgnore Ignore
— Open
— Closed (for SIL applications)
Fault repeater: Output represents Input Fault status

Logical Function: visible only when selected in “Output source”
Allows the logical binding of 2 or more (up to 8) Inputs.

- AND Output represents AND logical function of selected Inputs,
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- OR Output represents OR logical function of selected Inputs.

3.5.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

E G.M. International - SWC5090 Configuration Software - D5231E\D6231E - = X
File  Settings ~ Module 7 Store to device Load from devics
Corfiguration  Monitor | Data Logger
Input Status Output Status

TN —— Tl E—

o — S —

e T —

A —— T

e oupus [

e T —

o — T —

S oupas [

Start

[Data Editing 2017 May 30 - 10:37:04

Figure 26: D5231E / D6231E Monitor screen.

INPUT STATUS:
e The status of each input is shown
— Open circuit  Open circuit fault (only for Proximity Inputs)

- Off Off
— On On
— Short circuit  Short circuit fault (only for Proximity Inputs)
OUTPUT STATUS:
e The status of each output contact is shown
— Open
— Closed

3.5.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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Bl G.M. International - SWC5090 Configuration Software - D5231E\D6231E - = x
File Settings Module 7 Store to device Load from device
Corfiguration  Monitor Data Logger
Farameters Setup
Days o X
Hours 0 ~
Minutes 1 ~
Scan Rate [s] 0.5 ~
Start Clear
Data Editing 2017 May 30 - 10:39:00

Figure 27: Data Logger screen.

PARAMETERS SETUP:
e Days: Number of days to acquire
e Hours: Number of hours to acquire
¢ Minutes: Number of minutes to acquire
e Scan rate: Frequency interval for acquisitions

3.6 D5240T

Note: Software revision of the module can be found by clicking on “Module > Show identification > Software revision”.
D5240T is a Digital Output Isolator, suitable for driving solenoid valves, visual or audible alarms or other process control
devices in Hazardous Area.
The Application Window user interface is organized into the following areas:

e Configuration

e Data Logger
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3.6.1 Configuration

File  Settings Module 7

E G.M. International - SWC5030 Cenfiguration Software - D5240T -

B X

Corfiguration ' Diatalogger

Edemal inputs status

START

Qutputs configuration
Hardwarz

Output 1 | Input 1 v
Output 2 | Input 2 ~
Output 3 | Input 3 ~

Module TAG

052407 Tag

|Data Editing

2017 May 26 - 14:01:49

Figure 28: D5240T configuration screen.

Configuration parameters can be read and written from the module or from saved file. It is also possible to reset the
module configuration to factory default settings. A report sheet containing complete configuration can be printed.

TAG: Identification of the specific operating loop of the module.

External inputs status: Status of each Input channel is indicated in the related field.
Outputs configuration: Each Output can be configured to be driven by an independent Input, or by its opposite.
D5240T Input can be Hardware (via Terminal blocks) and/or Software (via Modbus). Both types can be used to drive the

Output. For Software input see next Section.
Hardware input:
Output 1 to 3:
e Input1: Output represents Input1
e Input2 :Output represents Input2
e Input3: Output represents Input3
e Not Input1: Output represents Not Input1
e Not Input2 :Output represents Not Input2 *
e Not Input3: Output represents Not Input3 *

" Note: example: Input = 1; Output = 0
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Il G.M. International - SWC5090 Configuration Software - D5240T - = x
File  Settings Module 7 Load from device
Corfiguration  Datalogger
Bdemal inputs status Outputs corfiguration
Hardware Logical function ModBus
[ ] Output 1 |Input 1 | [AND Nore v
Qutput 2 | Input 2 ~ | |AND None ~
Quitput 3 | Input 3 ~| [AND None v
Wodule TAG
START D5240T Tag
|Data Editing 2017 May 26 - 14:06:55

Figure 29: D5240T Advanced configuration options.

ADVANCED OPTIONS:
Advanced options for configuration can be found by clicking on the “Module > Advanced Options” entry of the main menu.
Hardware and Software Input can be logically combined to drive the Output.

Hardware Input Logical function Software Input Output
0 AND 0 0
0 AND 1 0
1 AND 0 0
1 AND 1 1
0 OR 0 0
0 OR 1 1
1 OR 0 1
1 OR 1 1

Note: Selecting “Not Input” changes Input to opposite state (1 to 0; 0 to 1).
Note: Only when the selected Modbus input is different from “None”, the hardware input can be set to “None”.

3.6.2 DataLogger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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m G.M. Internatienal - SWC5090 Configuration Software - D5240T - == X

File  Settings Module 7

Store to device Load from device

Corfiguration : Datalogger ;

Parameters Setup

Days 0
Hours 0
Minutes 1

Scan Rate [s] 0.5

Start

Clear

Data Editing

2017 May 26 - 14:10:33

PARAMETERS SETUP:

Days: Number of days to acquire
Hours: Number of hours to acquire
Minutes: Number of minutes to acquire
Scan rate: Frequency interval for acquisitions

Figure 30: Data Logger screen.

3.7 D5293S, D5294S (software revision 0)

Note: Software revision of the module can be found by clicking on “Module > Show identification > Software revision”.
The D5293S-D5294S Application Window user interface is organized into three Tabs:

Configuration
User Manual Settings
Fault Conditions Monitoring
- Tag
Acquire Functions
Continuous Scan
Monitor
— Measured Values
— Graph
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e Data Logger

3.7.1  Configuration

3.7.1.1 Continuous Scan

=

Cortinuous Scan

Stop

Figure 31: Continuous Scan box.
By pressing the “Start” button in the Continuous Scan box (see Figure 31), the module starts acquiring the data field (in

the Measured Values) periodically. To interrupt data acquisition press the same button — this time the label will be
“Stop” — shall be pressed.

3.71.2 Tag

Tag

loop

Figure 32: Tag box.

The Tag (see Figure 32) provides a label that can be associated to the specific loop.
3.7.1.3 User Manual Settings

Izer Manual Settings

Load Supply Voltage RMS (V] 238
Load Cument RMS (4) 0.083
Load OFF Resistance (Ohm) 157
lsolation Resistance {kOhm) 450
Supphy Voltage Limits (= V) 1.2
Load Cumert Limits (= A) 0.005
Load OFF Res. Limits (£ Chm) 25
Isolation Res. Limit {cOhm) KO

Figure 33: User Manual Settings box.

User Manual Settings (see Figure 33) can partially be acquired through the Acquire Functions and/or changed
manually before being written to the D5293S/D5294S module through the “Write to Module” button on the Menu Bar.
User Manual Settings include:
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Load Supply Voltage RMS (V)

indicates the RMS voltage that is actually applied (in ON State, load energized) or that will be applied (in OFF
State, load de-energized) to the load.

e Load Current RMS (A)

represents the RMS current that is flowing through the load (hence it will be zero in OFF state).
¢ Load OFF Resistance (Q)

is the load resistance measured in OFF State. In ON State, this value will remain at the saturation value (5 kQ)
e Isolation Resistance (kQ)

shows the leakage resistance to earth. Also the Isolation Resistance is measured only in OFF State; during ON
State, it goes to the saturation value of 3 MQ

e Coil Integrity

monitors the status of the relay coil in ON State: “FAIL” indicates that a relay coil is in short-circuit
e Driver Status

indicates whether the load has been energized (“ON”) or not (“OFF”)

User Manual Settings specify nominal values and limits that will activate the fault indication (red LED and two fault relay
contacts). See Section 3.7.1.4 for more details.

Remember that only after pressing the “Write to Module” button on the Menu Bar User Manual Settings and Fault
Conditions Monitoring become effective.

See Section 3.7.1.4 for an explanation of the color indicators on the left.

3.7.1.4 Fault Conditions Monitoring

Fault Conditions Manitaring

Load Supply Voltage
Load Cumerit

[] Load OFF Resistance
[] Isolation Resistance

I Coil Integrity

Figure 34: Fault Conditions Monitoring box.

Fault Conditions Monitoring (see Figure 34) indicate which subset of the User Manual Settings shall activate the fault.
Therefore:
e If Load Supply Voltage is enabled,
a measured Load Supply Voltage RMS outside the specified limits will activate the fault.
e If Load Current is enabled,
a measured Load Current RMS outside the specified limits will activate the fault.
e If Load OFF Resistance is enabled,
a measured Load OFF Resistance outside the specified limits shall activate the fault.
e If Isolation Resistance is enabled,
only a measured Isolation Resistance below the specified limit shall activate the fault.
e If Coil Integrity is enabled,
a coil short circuit in ON state shall activate the fault.
Note that, by activating the monitoring of a fault condition, the related color indicator on the left side becomes brighter

together with the corresponding measured value and user manual settings. This color policy allows a fast identification of
the quantities that contribute to the fault activation.
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Fault Conditions Monitoring are combined with the Driver Status. While the Load Supply Voltage RMS can always be
effective, the Load Current RMS and Coil Integrity can be active only during the ON State, whereas the Load OFF
Resistance and the Isolation Resistance only during the OFF State.

Note also that only after pressing the “Write to Module” button on the Menu Bar the User Manual Settings and the
Fault Conditions Monitoring will be saved onto the module, hence becoming effective.

3.4.1.5 Fault Activation

The fault is activated if at least one of the following conditions are met:

e Load Supply Voltage Monitoring is enabled AND
((Load Supply Voltage RMS < Load Supply Voltage RMS Nominal — Supply Voltage Limits) OR
(Load Supply Voltage RMS > Load Supply Voltage RMS Nominal + Supply Voltage Limits))

e Load Current Monitoring is enabled AND the load is Activated AND
((Load Current RMS < Load Current RMS Nominal - Load Current Limits) OR
(Load Current RMS > Load Current RMS Nominal + Load Current Limits))

¢ Load OFF Resistance Monitoring is enabled AND the load is De-activated AND
((Load OFF Resistance < Load OFF Resistance Nominal — Load OFF Resistance Limits) OR
(Load OFF Resistance > Load OFF Resistance Nominal + Load OFF Resistance Limits))

e |Isolation Resistance Monitoring is enabled AND the load is De-activated AND
(Isolation Resistance < Isolation Resistance Nominal - Isolation Resistance Limit)

e Coil Integrity Monitoring is enabled AND the load is Activated AND Coil Integrity is FAIL.

Active Driver Status
Monitoring OFF State ON State
Load Vnom _Vlim SVmeas Vnom _Vlim SVmeas
Supply Vmeas <Vnom _Vlim or Vnom +Vlim <Vmeas Vmeas <Vnom _Vlim or Vnom +Vlim <Vmeas
VOItage Vmcas SVnom +Vlim Vmcas SVm)m +Vlim
d Inom - Ilim = Imcas
Loa NOt a I|Cab|e meas < Inom - Ilim or Inom + Ilim < Imeas
Current
Imeas = Inom + I]im
d Rnom - R]im = Rmeas
Il?_ggstgrfclze Rmeas < nom Rlim or Rnom + Rlim < cas NOt a Iicable
Rmeas = Rnom + I:zlim
Isqlatlon R.<R -R._ R, —Rin SR Not applicable
Resistance
coil Not applicable FAIL oK
Integrity

Table 1: Combination of Monitoring functions activation with Driver Status.

Table 1 shows how the activation of the various Monitoring functions combines with the Driver Status: a red cell indicates
that the fault can be activated, while a green cell indicates that the fault cannot be activated.
Note again that only after pressing the “Write to Module” button on the Menu Bar, the User Manual Settings and Fault
Conditions Monitoring will be exported to the module, hence becoming effective.
When the fault is activated, the red LED is lighted and the two fault relays open. On the Application Window the
Measured Values that caused the fault turn red.

3.7.1.5 Acquire Functions

Acqguire Functions

[ Acquire OM parameters

Figure 35: Acquire Functions box.

The Acquire Functions (see Figure 35) allows the user to acquire the Measured Values to the User Manual Settings.




c I Document code: ISM0154 Revision: 10
Sl i ot (o s Installation and use of the SWC5090
20852 Villasantgy MB - Italy Configuration Software Sheet 31 of 56

These functions ease the user’s task, while avoiding that the technical details (supply voltage, load current, load
resistance, etc.) of the application are necessary for the module configuration. If the load is de-energized (OFF State), the
“Acquire OFF parameters” button will copy the Load Supply Voltage RMS and the Load OFF Resistance to the
corresponding User Manual Settings. If the load is energized (ON State), the “Acquire ON parameters” button will
copy the Load Supply Voltage RMS and the Load Current RMS to the corresponding User Manual Settings.

Note that the data acquisition button can be pressed only when the continuous scan is active, hence avoiding to acquire
outdated field values.

3.7.2 Monitor
3.7.2.1 Measured Values

¥ G.M. International - SWC5090 Configuration Software - D52945 - * EI = @

File  Settings Module ? | Witeto Module | | Read from Module |

Configuration [} Morior | Data Logger

Measured Values

Load Supply Voltage RMS (V) Load Cument RMS {A) —

Load OFF Resistance (0) Isolation Resistance (K() Start

Driver Status Coil Integrity S—
Graph

Load Supply Voltage RMS Load Cument RMS (A} Isolation Resistance (K2) Load OFF Resistance ((Q2)

D52948 graph

0.0 02 04 06 0.8 1.0 12
Time

|Data Editing 2015 Feb 27 - 14:32:35
Figure 36: Monitor Tab.

Measured Values (see Figure 36) are periodically acquired from the field, when the Start/Stop is activated (odometer
running in the Bottom Bar). When the Start/Stop button is deactivated, the Measured Values remain frozen to the last
field acquisition value.

Measured Values include:
¢ Load Supply Voltage RMS (V)

indicates the RMS voltage that is actually applied (in ON State, load energized) or that will be applied (in OFF
State, load de-energized) to the load.

¢ Load Current RMS (A)
represents the RMS current that is flowing through the load (hence it will be zero in OFF state).
¢ Load OFF Resistance (Q)
is the load resistance measured in OFF State. In ON State, this value will remain at the saturation value (5 kQ)

¢ Isolation Resistance (kQ)
shows the leakage resistance to earth. Also the Isolation Resistance is measured only in OFF State; during ON
State, it goes to the saturation value of 3 MQ

e Coil Integrity
monitors the status of the relay coil in ON State: “FAIL” indicates that a relay coil is in short-circuit

e Driver Status
indicates whether the load has been energized (“ON”) or not (“OFF”)

See Section 3.7.1.4 for the explanation of the color indicators on the left.

3.7.2.2 Graph

It is possible to show the value of a variable on a graph. To do so, start acquisition by pressing the Start button and then
select the desired variable by checking the corresponding checkbox.

Note that only one variable can be seen at a time.
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3.7.3 Examples and Applications
Detailed examples of D5293S and D5294S configurations and applications can be found in a dedicated application note

APNO0036 which can be found on our website www.gmintsrl.com.

3.8 D5293S (software revisions 1 and 2) °

Note: Software revision of the module can be found by clicking on “Module > Show identification > Software revision”.
The D5293S is a relay module suitable for the switching of safety related circuits, up to SIL 3 level according to
IEC 61508:2010 Ed.2, for high risk industries.
The Application Window user interface is organized into the following areas:
e Configuration
e Monitor
e Data Logger

3.8.1 Configuration

@ G.M. International - SWC5090 Configuration Software - D52035 - == B=R===
File  Settings Module 7 [ Whiteto Module | [ Read from Module |
Corfiguration | Monitor I Data Logger
User Manual Settings
Load Supply Voltage RMS Load Cumrert RMS
- Voltage Upper Limit (V) 260.0 - Curent Upper Limit (&)  4.000
- Voltage Lower Limit (v) ~ 10.0 - Current Lower Limt () 0.005
Fautt Condttions Monitoring {Command Status [ON]) Fault Conditions Monitaring (Command Status [OFF])
Load Supply Voltage Load Supply Voltage
Load Curent Acquire Off Params
Coil Integrity
Tag
052935
Continuous Scan
[ Invert fautt relay
|Data Editing || 2015 Feb 27 - 14:33:22

Figure 37: D5293S Configuration screen.

Configuration parameters can be read and written from the module or from saved file.
It is also possible to reset the module configuration to factory default settings.

" For software revision n. 2, it is not possible to disable hysteresis and to check coil integrity.
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A report sheet containing complete configuration can be printed.
User Manual Settings:
Load Supply Voltage RMS
e Voltage Upper Limit (V): Maximum allowed load RMS voltage
e Voltage Lower Limit (V): Minimum allowed load RMS voltage
Load Current RMS
e  Current Upper Limit (A): Maximum allowed load RMS current
e  Current Lower Limit (A): Minimum allowed load RMS current
FAULT CONDITIONS MONITORING:
(Command Status [ON]): Faults contributing to the output cumulative fault when the driver is on.
FAULT CONDITIONS MONITORING:
(Command Status [OFF]): Faults contributing to the output cumulative fault when the driver is off.
e Load Supply Voltage: When checked, the load supply voltage can activate the cumulative fault.
e Load Current: When checked, the load current can activate the cumulative fault.
e Coil Integrity: When checked, the short circuit of any coil can activate the cumulative fault (only until software
revision 1).
TAG: Identification of the specific operating loop of the module.
ACQUIRE FUNCTIONS: Acquisition and saving of the diagnostics field parameters.
e Acquire OFF parameters: The currently measured OFF parameters are copied to the USER MANUAL SETTINGS
(available only when the driver is OFF).
e Acquire ON parameters: The currently measured ON parameters are copied to the USER MANUAL SETTINGS
(available only when the driver is ON).
CONTINUOUS SCAN: Continuous measurement of the field parameters.
o Start/Stop: Activates/de-activates the measurement of the field parameters.
INVERT FAULT RELAY: When not checked, the output fault contacts open in case of fault. When checked, the output
fault contacts close in case of fault.
ADVANCED OPTIONS:
Advanced options for configuration can be found by clicking on the “Module > Advanced Options” entry of the main menu.

© G.M. International - SWC5090 Configuration Software - D52935 - = EI = @
File  Settings | Module | ? Wiite to Modue | [ Read from Module |
Configuration | Mors Select Model 3
Show Identificati
User Manual Setti R
Load Factory Settings
Advanced Options 4 Load interruption  »
Input impedance 3
Load Supply Voltage RMS B umert RMS
Hysteresis 3
- Voltage Upper Limit (V) 260.0 - Current Upper Limit (&) 4000
- Voltage Lower Limit (v}~ 10.0 - Curent Lower Limit (3)  0.009
Fautt Conditions Monitoring (Command Status [ON]) Fault Conditions Monitoring (Command Status [OFF])
V| Load Supply Voltage /| Load Supply Voltage
7| Load Currert Acquire Off Params
V| Coil Integrity
Tag
052935
Continuous Scan
Invert fault relay
Start
\Data Editing 2015 Feb 27 - 14:34:07

Figure 38: Advanced configuration options.

Load Interruption:



c I Document code: ISM0154 Revision: 10

Vo tPersis Installation and use of the SWC5090
20852 V“.a::n‘::"MB’_S;;‘T;” Configuration Software Sheet 34 of 56

+/ 000 +/ G

5 4 56 b

13

13

Load 14

16
14

16 Load

et

LG -AAG
Figure 39: Bipolar (on the left) and unipolar (on the right) load interruption.

¢ Bipolar: Load is disconnected by removing connection to both AC/DC lines
e Unipolar: Load is disconnected only from one AC/DC line.
Input impedance:
e Mirror: The fault in the field is directly mirrored to the PLC DO.
e Always OFF: Input impedance seen by the PLC with Pulse Testing is always HIGH.
e Always ON: Input impedance seen by the PLC with Pulse Testing is always LOW.

3.8.1.1 Hysteresis (always visible since software revision 2):

Load Supply Violtage RMS Load Cumrert RMS
- Voltage Upper Limit (V) 2600 - High hysteresis = 20.0 -Cument Upper Limit (4)  4.000 - High hysteresis 0200
-Voltage Lower Limt (V) 100  -Lowhysteresis 1.0 -Curent Lower Limit (8) 0005 | owhysteresis  0.001

Figure 40: D5293S with Hysteresis enabled.

e ON:

— Upper Fault condition is activated when signal is higher than Upper Limit and deactivates when lower than Upper
Limit — High Hysteresis value.

— Lower Fault condition is activated when signal is lower than Lower Limit and deactivates when higher than Lower
Limit + Low Hysteresis value.

e OFF: No hysteresis is present and fault conditions are triggered exactly when signal is higher or lower than defined
limits.
3.8.2 Monitor

The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.
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¥ G.M. International - SWC5090 Configuration Software - D52935 - * EI = @

File  Settings Module ? | Writeto Module | | Read from Module |

Corfiguration [ Monitor || Data Logger

Measured Values

Load Supply Voltage RMS (V) Load Cument RMS (A) —

Driver Status Coil Integrity Start

Graph
Load Supply Voltage RMS Load Cumrent RMS (A}

D52938 graph

0.0 02 04 06 0.8 1.0 12
Time

|Data Editing ,m
Figure 41: D5293S Monitor screen.

Measured Values (see Figure 41) are periodically acquired from the field, when the Start/Stop is activated (odometer
running in the Bottom Bar). When the Start/Stop button is deactivated, the Measured Values remain frozen to the last
field acquisition value.

Measured Values include:

e Load Supply Voltage RMS (V)
indicates the RMS voltage that is actually applied (in ON State, load energized) or that will be applied (in OFF
State, load de-energized) to the load.

¢ Load Current RMS (A)
represents the RMS current that is flowing through the load (hence it will be zero in OFF state).

e Coil Integrity
monitors the status of the relay coil in ON State: “FAIL” indicates that a relay coil is in short-circuit

e Driver Status
indicates whether the load has been energized (“ON”) or not (“OFF”)

3.8.21 Graph
It is possible to show the value of a variable on a graph. To do so, start acquisition by pressing the Start button and then
select the desired variable by checking the corresponding checkbox.

Note that only one variable can be seen at a time.

3.8.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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@ GM. ional - SWC5090 C ian Software - DS0720\DG0T2D - o @ |
File  Settings Module ? Wite to Module | [ Read from Module |
| Bonfgurtion | Menkor | Dete Lagger;
Parameters Setup
Dars
Hours
Minutes
Scan Rate [5]
Start ] [ Clear
|Data Editing | 2015 Feb 27 - 14:38:36

Figure 42: Data Logger screen.

PARAMETERS SETUP:
e Days: Number of days to acquire
e Hours: Number of hours to acquire
e Minutes: Number of minutes to acquire
e Scan rate: Frequency interval for acquisitions

3.9 D5294S, D5295S (software revisions 1 and 2)

Note: Software revision of the module can be found by clicking on “Module > Show identification > Software revision”.

D5294S and D5295S are relay module suitable for the switching of safety related circuits, up to SIL 3 level according to
IEC 61508:2010 Ed.2, for high risk industries.
The Application Window user interface is organized into the following areas:

e Configuration

" For software revision n. 2, it is not possible to disable hysteresis.
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e Monitor
e Data Logger

3.9.1 Configuration

ZE G.M. Intemational - SWC5090 Canfiguration Seftware - D52345 - * - * S G.M. Intemational - SWCS080 Configuration Software - D52955 - * = x
File Seftings Module 7 Load from device File Settings Module 7 Load from device
Corfigration | Meritor Data Logger

Configuration  Meritor Data Logger

User Manusl Seltings L i
Load Supoly Vatage RMS Load Curent AMS Hest oyl Setie.

Load Supoly Voltage RMS Load Cument RMS
~Vohiage Upper Ume (V) [260.0 ~Current Upper Limt (3) [ 5000 | ~Voltage Upper Lmk (v) [ 260.0 ~Curment Upper Linit () [ 5.000 |
~Votioge Lower Limé ) [ 100 | ~Curent Lower Limi () | 2005 Voltage Lower Limé () [ 100 | ~Curent Lower Limit (4) | 0005
Load OFF Resistance lsclation Resistance Load OFF Resistance Isclation Registance
- Resistance Upper Lirit (0} | 43000 - Resistance Upper Lint (0) [ 23000
- Fesistance Lower Limt (K0) | 100 (e

~Resistance Lower Limit (K} | 100 |
- Resistance Lower Limt () |5 —

- Resistance Lower Limt {0} 5

Fault Conditions Moniioding (Command Status [ON]) Faut Condiions Monitoring (Command Siatus OFF] Aequire Functions Fault Conditions Monitoring (Command Status ION] Faut Condtions Monttoring (Command Status [OFF]) Acquire Functions

[ Load Supply Voltage [ Load Suppiy Voltage [ Load Supply Vottage [ Load Supply Valtage

[ Load Curert Load Curert Acquire Off Params i 3 Load Curort Acquire Of Params

[ Col integrity Coil tegity = [ Col Integrty Coil Intagity

- (7 Load OFF Resistance Teg [ Load OFF Resistance Tax
stance [ tsolstion Resistance L] [ Isciztion Resistance L]
Contact position in cas of faut Contruous Scan Contact postion in cass of faut Gortimmios Soeri
® Open ® Open
G Start Gicias Start
[Data Editing [ 2017 May 29 - @:35:39 [Data tditing [ 2017 May 29 - 08:36:06

Figure 43: D5294S (on the left) and D5295S (on the right ) configuration screen (software revision 1).

T G.M. Intemational - SWC090 Configuration Software - DS2345 - * - * T G.M. Intemational - SWC5080 Configurstion Seftware - DS2355 - * - 3
File Settings  Module 7 Load from device File Settings  Module 7 Load from device
Corfiguration  Moritor Data Logger Configuration  Moritor  Diats Logger
User Manugl Settings User Manugl Settings
Load Supoly Voktage RMS Load Cument RMS Load Supoly Voktage RMS Load Cument RMS
~Voltage Upper Ume (V) [260.0 | - High ysteresis [ 200 | ~Cument Upper Limt (%) [5000 | - High hysteresis [0.200 ~Voltage Upper Lme (V) [260.0 | - High hysteresis [ 200 | ~Current Upper Limt(8) [5.000 | - High hysteresis [0.200
~Voliage Lower Uit (V) [ 100 | - Low hysteresis | 10 | ~Current Lower Limt () | 0005 | Low hysteresss [ 0,001 ~Voliage Lower Uit ) | 100 | - Lowhysterssis | 10 | ~Current Lower Linit () (0005 | _Low hysteresss [ 0,001
Load OFF Resistance lsalation Resistance Load OFF Resistance lsalation Resistance
~Resistance Upper Lint (0] [49000 | - Hgh hysteresis | 2000 | : . ~Resistance Upper Lint (0) 43000 - High hysteresis | 2000 | : .
—_— ~Resistance Lowsr Limt (<0) | 100 | - Low hysterssis | 10 | —_— ~Resistance Lower Lt 00 | 100 | ~Low hysteresis | 10 |
-Resitance Lower Umt (0) | 8 | - Lowrysterssis | 1 i -Resistance Lower Umt (Q) | 5| -Lowkysteresis | 1 i
Fault Canditions Montorng (Cammand Status [ON] Faut Condeions Monitaring Command Status [OFF Acquirs Functions Fault Candiions Montarng (Command Status [ON]) Faut Condeions Monitaring Command Status [OFF) Acquire Functions
[ Load Supply Vokiage [ Load Supply Voltage [ Load Supply Vokiage [ Load Supply Voltage
[] Load Cumert Load Curert il Load Curert [ Load Curent il
4 Col ntegrny Col Ftegity [ Col ntegrny Col Fegity
o8 [ Load OFF Resistance Teg [ Lond OFF Resistance Tag
: 052345 2 D52955
3 [ tsolstion Resistance [ lsciation Resistance tsolstior
Contact postion n cass of fault N Contact position in cass of faut P
® Open ® Open
O Closed o O Closed o
[Data Editing 2017 May 29 - 08:35:39 [Data Editing 2017 May 29 - DB:36:06

Figure 44: D5294S (on the left) and D5295S (on the right ) configuration screen (software revision 2).

Configuration parameters can be read and written from the module or from saved file. It is also possible to reset the
module configuration to factory default settings. A report sheet containing complete configuration can be printed.
User Manual Settings:

e Load Supply Voltage RMS
— Voltage Upper Limit (V): Maximum allowed load RMS voltage
— Voltage Lower Limit (V): Minimum allowed load RMS voltage
e Load Current RMS
— Current Upper Limit (A): Maximum allowed load RMS current
— Current Lower Limit (A): Minimum allowed load RMS current
e Load OFF Resistance
— Resistance Upper Limit (Q): Maximum allowed load OFF resistance
Resistance Lower Limit (Q): Minimum allowed load OFF resistance
e Isolation Resistance

— Resistance Lower Limit (kQ): Minimum allowed load-to-earth isolation resistance
FAULT CONDITIONS MONITORING (Command Status [ON]):
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Faults contributing to the output cumulative fault when the driver is on.
e Load Supply Voltage:
When checked, the load supply voltage can activate the cumulative fault.
e Load Current: (only for D5294S)
When checked, the load current can activate the cumulative fault.
e Coil Integrity:
When checked, the short circuit of any coil can activate the cumulative fault.
e Load OFF Resistance: (only for D5295S)
When checked, the load OFF resistance can activate the cumulative fault.
e Isolation Resistance: (only for D5295S)
When checked, the load-to-earth isolation resistance can activate the cumulative fault.
FAULT CONDITIONS MONITORING (Command Status [OFF]):
Faults contributing to the output cumulative fault when the driver is off.
e Load Supply Voltage:
When checked, the load supply voltage can activate the cumulative fault.
e Load Current: (only for D5295S)
When checked, the load current can activate the cumulative fault.
¢ Load OFF Resistance: (only for D5294S)
When checked, the load OFF resistance can activate the cumulative fault.
¢ Isolation Resistance: (only for D5294S)
When checked, the load-to-earth isolation resistance can activate the cumulative fault.
TAG: Identification of the specific operating loop of the module.
ACQUIRE FUNCTIONS: Acquisition and saving of the diagnostics field parameters.
e Acquire OFF parameters: The currently measured OFF parameters are copied to the USER MANUAL SETTINGS
(available only when the driver is OFF).
e Acquire ON parameters: The currently measured ON parameters are copied to the USER MANUAL SETTINGS
(available only when the driver is ON).
CONTINUOUS SCAN: Continuous measurement of the field parameters.
e Start/Stop: Activates/de-activates the measurement of the field parameters.

INVERT FAULT RELAY: When not checked, the output fault contacts open in case of fault. When checked, the output
fault contacts close in case of fault.

@ G.M. International - SWCS090 Configuration Software - D52055 - * [o] ® =

File  Settings | Module | 7 [ Wiieto Module | [ Readfrom Module |

Select Model 3

Corfiguration 57";10?

User Manual St Show Identification

Load Supply Load Factory Settings Load Curert RMS

‘ Advanced Options » Load Type

- Voltage Upper Limit (V) 260.0 Load interruption it Upper Limit (A)  4.000

- Voltage Lower Limit (v) ~ 10.0

3
»
Input d 3
nputimpedance it Lower Limit (8)  0-005
»

Hysteresis

Load OFF Resistance Isolation Resistance

- Resistance Upper Limit (Q) 49000

- Resistance Lower Limit () 5

Fault Conditions Monitoring (Command Status [ON])
/| Load Supply Voltage
Load Current
/| Coil Integrity
/| Load OFF Resistance

/| Isolation Resistance

Invert fault relay

- Resistance Lower Limit (KQ) 2000

Fault Conditions Monitoring (Command Status [OFF])
V| Load Supply Voltage
7| Load Cument Acquire Off Params

Acquire Functions

Coil Integrity
Load OFF Resistance Tag

052955
Isolation Resistance

Continuous Scan

Start

|Data Editing

2015 Feb 27 - 14:41:24

Figure 45: D5294S, D5295S Advanced configuration options.

ADVANCED OPTIONS:

Advanced options for configuration can be found by clicking on the “Module > Advanced Options” entry of the main menu.
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Load Type:
e Auto: automatically selects Load type between Generic Load and Solenoid.
¢ Generic Load: any load up to 50 kQ resistance.

e Solenoid: specific for Solenoid loads up to 10 kQ; resistance is calculated even in presence of series connected
diodes.

Load Interruption:

+IAC +/ 0O

wd 1 wh 3
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Load 14
16
14
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ool

LA By
Figure 46: Bipolar (on the left) and unipolar (on the right) load interruption.

e Bipolar: Load is disconnected by removing connection to both AC/DC lines
e Unipolar: Load is disconnected only from one AC/DC line.
Input impedance:
e Mirror: The fault in the field is directly mirrored to the PLC DO.
e Always OFF: Input impedance seen by the PLC with Pulse Testing is always HIGH.
e Always ON: Input impedance seen by the PLC with Pulse Testing is always LOW.

3.9.1.1 Hysteresis (always visible since software revision 2):

User Manual Settings
Load Supply Voltage RMS Load Cument RMS

- Voltage Upper Limit (V) | 260.0 | - High hysteresis - Cument Upper Limit (A) | 5.000 | - High hysteresis | 0.200
- Voltage Lower Limit (V) - Low hysteresis - Cument Lower Limit (8) | 0005 |~ Low hysteresis | 0.001

Load OFF Resistance Isolation Resistance

- Resistance Upper Limit (0} | 49000 | - High hysteresis | 2000

- Resistance Lower Limit (KOl -1 00 | - Low hysteresis 10
- Resistance Lower Limit ({1} - Low hysteresis -

Figure 47: D5294S, D5295S with Hysteresis enabled.

e ON:
— Upper Fault condition is activated when signal is higher than Upper Limit and deactivates when lower than Upper
Limit — High Hysteresis value.
— Lower Fault condition is activated when signal is lower than Lower Limit and deactivates when higher than Lower
Limit + Low Hysteresis value.
e OFF:

— No hysteresis is present and fault conditions are triggered exactly when signal is higher or lower than defined
limits.
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3.9.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

Bl G.M. Intemational - SWC5080 Configuration Software - D52845 - * = X
File Settings Module 7 Store to device Load from device
Configuration MDI’"‘DT Data Logger
Measured Values
Load Supply Voktage RMS (V) l:l Load Currert RMS (A) Not available
Load OFF Resistance (1) l:l Isolation Resistance (KO) l:l Start
Driver Status 1 Coil Integity Not available
Load Supply Voltage RMS {V) Load Cument RMS (4) Isolation Resistance (KOhm) Load OFF Resistance (Ohm) Chart seftings
D5294S — Load supply voltage
3004
2504
2004
= 1560+
100
504
0
0 30 60 90 120 150 180
[Data Editing 2017 May 29 - 09:21:28

Figure 48: D5294S, D5295S Monitor screen.

Measured Values (see Figure 48) are periodically acquired from the field, when the Start/Stop is activated (odometer
running in the Bottom Bar). When the Start/Stop button is deactivated, the Measured Values remain frozen to the last field
acquisition value.
Measured Values include:
¢ Load Supply Voltage RMS (V)
indicates the RMS voltage that is actually applied (in ON State, load energized) or that will be applied (in OFF
State, load de-energized) to the load.

e Load Current RMS (A)
represents the RMS current that is flowing through the load (hence it will be zero in OFF state).

e Load OFF Resistance (Q)
is the load resistance measured in OFF State. In ON State, this value will remain at the saturation value (5 kQ)

e Isolation Resistance (kQ)
shows the leakage resistance to earth. Also the Isolation Resistance is measured only in OFF State; during ON
State, it goes to the saturation value of 3 MQ

e Coil Integrity
monitors the status of the relay coil in ON State: “FAIL” indicates that a relay coil is in short-circuit

e Driver Status
indicates whether the load has been energized (“ON”) or not (“OFF”)

3.9.21 Graph

It is possible to show the value of a variable on a graph. To do so, start acquisition by pressing the Start button and then
select the desired variable by checking the corresponding checkbox.

Note that only one variable can be seen at a time.

3.9.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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Hours 0 A
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Scan Rate [s] 0.5 v
Start Clear
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Figure 49: Data Logger screen.

PARAMETERS SETUP:
e Days: Number of days to acquire
e Hours: Number of hours to acquire
¢ Minutes: Number of minutes to acquire
e Scan rate: Frequency interval for acquisitions

3.10 D5264S

D5264S is Load Cell/Strain Gauge Bridge Isolating Converter module suitable for applications requiring SIL 2 level
(according to IEC 61511) in safety related systems for high risk industries.

The Application Window user interface is organized into the following areas:
e Configuration
— Input
— Output
— Alarm
e Monitor
e Data Logger
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3.10.1 Configuration
3.10.1.1 Input/ Output

Il G.M. International - SWC5090 Configuration Software - D52645 - = x

File  Settings | Module | 7 Load from device
Corfiguration  Mon| Select Model 3
Input\Output | A Show Identification
Load Factory Settings
Advanced Options »
Input Output
Input range v Unipolar
C ion SpEeTTSIOWTUOTE] o 2
onversion Bipolar
Tag D52645
Calibration
Type 12-20 mA Source v
Maximum weight [Div] 100000
Downscale : OUT [wA] ZDDD — ljl IN [Div]
Reference weight [Div] 0 Upscde - OUT (] — [ 100000] NI
Acquire Zero Acquire Reference Under Rangs [uA]

Over Ranga [

[Data Editing [ 2017 May 29- 10:04:00
Figure 50: D5264S Input / output configuration screen.

INPUT
Conversion speed (Input data acquisition time):
e Slow: 100 ms
e Fast:12.5ms
Tag: 16 alphanumerical characters
Maximum weight: configurable from 0 to 100000 divisions. Higher values lead to greater resolutions.
Reference weight: weight used for calibration. Configurable form 0 to selected maximum weight.
Acquire Zero: press button to start the zero acquiring procedure.
Acquire Reference: press button to start reference acquiring procedure

Input range:
e Unipolar: the input scale ranges from 0 to the maximum value. This scale is particularly indicated to measure a
weight.

e Bipolar: the input scale ranges form — to + maximum value. This scale is particularly indicated for other sensors, i.e.
strain gauges.

OUTPUT
Type:

e 0-20 mA Sink

e 4-20 mA Sink

e Custom Sink All Output parameters are fully customizable.

e 0-20 mA Source

e 4-20 mA Source

e Custom Source All Output parameters are fully customizable.
Downscale: analog output downscale in normal working condition (range 0 to 24 mA)
Upscale: analog output downscale in normal working condition (range 0 to 24 mA)
Underrange: analog output downscale in underrange condition (range 0 to 24 mA)
Overrange: analog output downscale in overrange condition (range 0 to 24 mA)
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Corfiguration  Monitor Data Logger
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Alarm
Alam configuration MNaone ~
Contact posttion in case of alam | Open “
Low Set [Div]
Low Hysteresis [Div] 0
High Set [Div]
High Hysteresis [Div] |0 %‘
On Delay [s] D
Cff Delay [s] D
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Figure 51: D5264S Alarm configuration screen.
ALARM
Configuration:
e None alarm is disabled
e Low alarm is triggered when source descends below “Low Set”
e High alarm is triggered when source ascends over “High Set”
e Window alarm is triggered below “Low Set” and above “High Set”

Contact position in case of alarm:
e Open: alarm output is closed under regular working conditions, and it opens in case of alarm
e Closed: alarm output is open under regular working conditions and it closes in case of alarm
Low Set: source value below which the alarm is triggered (in Low, Window)
Low Hysteresis: hysteresis on the low set value
High Set: source value above which the alarm is triggered (in High, Window)
High Hysteresis: hysteresis on the high set value

On Delay: time for which the source variable has to be in alarm condition before the alarm output is triggered,;
configurable from 0 to 1000 seconds in steps of 100 ms

Off Delay: time for which the source variable has to be in normal condition before the alarm output is deactivated,;
configurable from 0 to 1000 seconds in steps of 100 ms

3.10.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.
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Figure 52: D5264S Monitor screen.

The display shows Input and Theoretical Output values, fault and alarm status and a graph of chosen variable.

3.10.2.1 Input
Input variable is shown as it is detected by the module.

3.10.2.2 Output
This value represents the theoretical output. During certain conditions, this value may differ from the measured value at
output terminal blocks.
3.10.2.3 Alarm status
Alarm status is represented by a LED, which is RED when activated.
The LED status reflects the status of the Alarm exactly as configured.

3.10.2.4 Graph
The graph can show only one variable that must be chosen from the checkboxes above.

3.10.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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Figure 53: Data Logger screen.

3.11 D5254S /| D6254S

D5254S / D6254S is Power Supply Repeater and Trip Amplifier.
The Application Window user interface is organized into the following areas:

e Configuration
— Input
— Output
— Alarm

e Monitor

e Data Logger

3.11.1 Configuration
3.11.1.1 Input/ Output

il G.M. International - SWC5080 Configuration Software - D52545 -

File Settings Module 7

- X

Load from device

Configuration  Monitor  Data logger

Inputs and output  Alamms

Input
Input type Current o
Range 0/4 = 20mA

Input conversion (@ Linear

O Square roat
Out of range

Low threshold ]  [3200
High threshold [WA]  [22000

Tag D52545\D62545

Qutput

Typs 4-20mA Source

-
Domwnscale : OUT [uA] - IN [uA)
Upscale  :OUT [ua] - IN (2]
Wi [

Over range ]

Fault output value [wA]

Fault in case of : Out of range

|Data Editing

2017 May 29 - 10:42:01

Figure 54: D5254S / D6254S Input / output configuration screen.
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INPUT
Input Type:
e current
e voltage
Range:
e 0/4-20 mA represents the allowed input current ranges
e 112V represents the allowed input voltage ranges
Input conversion:
e Linear the module repeats in linear scale the input to the output
e Square root the module converts in square root scale the input to output

Out of range:
e Low threshold input value below which the fault is triggered
e High threshold input value above which the fault is triggered
Tag: 16 alphanumerical characters
OUTPUT
Type:
e 0-20 mA Sink
e 4-20 mA Sink
e Custom Sink all Output parameters are fully customizable
e 0-20 mA Source
e 4-20 mA Source
e Custom Source all Output parameters are fully customizable
Downscale
analog output downscale in normal working condition (range 0 to 24 mA)
Upscale
analog output upscale in normal working condition (range 0 to 24 mA)
Under range
analog output value in under range condition (range 0 to 24 mA)
Over range
analog output value in over range condition (range 0 to 24 mA)
Fault Output Value
analog output value in case of fault condition (range 0 to 24 mA)
Fault in case of
analog output is forced to “Fault Output Value” when input is out of configured range
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Figure 55: D5254S / D6254S Alarm configuration screen.
ALARM
Type:
e None alarm is disabled
e Low alarm is triggered when input descends below “Low Set”
e High alarm is triggered when input ascends above “High Set”
e Window alarm is triggered below “Low Set” and above “High Set”
Alarm Lock:

alarm is inhibited until source ascends above or descends below the configuration parameters, and then, it behaves as
standard configuration.

NO contact position in case of alarm:
e Open alarm output is closed under regular working conditions and it opens in case of alarm
e Closed alarm outputis open under regular working conditions and it closes in case of alarm

Low Set:

input value below which the alarm is triggered (in Low, Window)

Low Hysteresis:

hysteresis on the low set value

High Set:

Input value above which the alarm is triggered

High Hysteresis:

hysteresis on the high set value

On Delay:

time for which the input has to be in alarm condition before the alarm output is triggered; configurable from 0 to 1000
seconds in steps of 100 ms.

Off Delay:

time for which the input has to be in normal condition before the alarm output is deactivated; configurable from 0 to 1000
seconds in steps of 100 ms.

FAULT
Alarm is triggered when input is out of configured range
In case of fault:

e Ignore alarm is affected
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e Lock status remains in the same status as it was before Fault occurred
e Alarm active alarm is triggered

e Alarm inactive alarm is deactivated
Alarm acknowledgement:

e Ignore alarm is automatically reset
e Active high a voltage source of 24 Vdc must be applied, at the relative terminals, to reset alarm
e Alarm active a voltage source of 0 Vdc must be applied, at the relative terminals, to reset the alarm

3.11.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

EIl G.M. International - SWC3090 Configuration Software - D52545 - = X
File Settings Module 7 Store o device Load from device
Configuration  Maniter} Data logger
Measured vaiue ] lIl Output fautt Mlam Status
Start Out of range Alam A Alam B
Vitwalouput Al [ 0|
Monitoring values
@ INPUT O OUTRUT sg;fés D5254S — Current 0/4 = 20 mA
24000
22000
20000+
18000
16000
T 14000
‘é 12000
~ 10000+
2000
6000
4000
2000
0 T T T T T 1
0 30 60 80 120 150 180
Time [s]
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Figure 56: D5254S / D6254S Monitor screen.

The display shows Input and Theorical Output values, fault and alarm status and a graph of chosen variable.
3.11.2.1 Input

Input variable is shown as it is detected by the module.
3.11.2.2 Output

This value represents the theorical output. During certain conditions, this value may differ from the measured value at
output terminal blocks.

3.11.2.3 Alarm status
Alarm status is represented by a LED, which is RED when activated.
The LED status reflects the status of the Alarm exactly as configured.
3.11.2.4 Fault
Fault status is represented by a LED, which is RED when activated.
3.11.2.5 Graph
The graph can show only one variable that must be chosen from the checkboxes above.

3.11.3 Data Logger
The SWCS5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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3.12 D5212Q / D6212Q

Figure 57: Data Logger screen.

D5212Q / D6212Q is Quadruple Repeater Power Supply.
The Application Window user interface is organized into the following areas:

Configuration
— Input
— Output
— Alarm
Monitor
Data Logger
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3.12.1 Configuration
3.12.1.1 Input/ Output

Ell G.M. International - SWC5080 Configuration Software - D5212Q - = X
File Settings Module 7 Load from device
Corfiguration ' Wonitor Data logger
Inputs  Outputs  Alam
Imput 1 Input 2
Range [4 = 20 mA] Range [4 = 20 mA]
Out of range Out of range
Low threshold 3200 Low threshold 3200
High threshold | 22000 Highthreshold | 22000
Tag [Channel 1] Tag [Channel 2]
Input 3 Input 4
Range [4 = 20 mA] Range [4 = 20 mA]
Out of range Out of range
Low threshold 3200 Low threshold 3200
Highthreshold 22000 Highthreshold 20800
Tag [Channel 3] Tag [Channel 4]
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Figure 58: D5212Q / D6212Q Input / output configuration screen.

INPUT
Out of range:
e Low threshold: input value below which the fault is triggered
e High threshold: input value above which the fault is triggered
Tag: 16 alphanumerical characters
OUTPUT
Type:
e 0-20 mA Source
e 4-20 mA Source
e Custom Source all output parameters are fully customizable
Downscale:
analog output downscale in normal working condition (range 0 to 24 mA)
Upscale:
analog output upscale in normal working condition (range 0 to 24 mA)
Under range:
analog output value in under range condition (range 0 to 24 mA)
Over range:
analog output value in over range condition (range 0 to 24 mA)
Fault output value:
analog output value in case of fault condition (range 0 to 24 mA)
Fault in case of:
analog output is forced to “Fault Output Value” when input is out of configured range
When the advanced settings button is clicked, the following settings box is shown.
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Figure 59: D5212Q / 6212Q advanced settings details.

Input A selector:

e Input 1: output represent Input1

e Input2: output represent Input2

e Input 3: output represent Input3

e Input4: output represent Input4
Output operations:

e None: output operations are disabled.

e  Subtraction: analog output represents the subtraction of the two selected input channels.

e Sum: analog output represents the sum of the two selected input channels.

e Maximum: analog output represents the higher of the two selected input ch.

e  Minimum: analog output represents the lower of the two selected input channels.
Input B selector: (it is shown when the output operations selected is not None)

e Input1: represents the second operand used for the output operation.

e Input 2: represents the second operand used for the output operation.

e Input 3: represents the second operand used for the output operation.

e Input4: represents the second operand used for the output operation.

3.12.1.2 Alarm

Bl G.M. Intemational - SWC5080 Configuration Software - D5212Q - * = X

File Settings Module 7

Store to device Load from device

Configuration ' Monitor  Data logger

Inputs  Outputs  Alam

Aarm 1

Type

None o

Input 1

None

Closed

Out of range

lgriors
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Figure 60: D5212Q / D6212Q Alarm configuration screen.
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ALARM
Type:

e None: alarm is disabled

e Low: alarm is triggered when input descends below “Low Set”

e High: alarm is triggered when input ascends above “High Set”

e Window: alarm is triggered below “Low Set” and above “High Set”
Alarm lock:

alarm is inhibited until source ascends above or descends below the configuration parameters, and then, it behaves as
standard configuration.

Input A selector:
e Input 1: alarm is triggered on Input1
e Input 2: alarm is triggered on Input2
e Input 3: alarm is triggered on Input3
e Input4: alarm is triggered on Input4
Output operations:
e None: output operations are disabled.
e Subtraction:analog output represents the subtraction of the two selected input ch.
e Sum: analog output represents the sum of the two selected input channels.
e Maximum: analog output represents the higher of the two selected input channels
e Minimum: analog output represents the lower of the two selected input channels
Input B selector: (it is shown when the output operations selected is not None)
e Input 1: represents the second operand used for the output operation
e Input 2: represents the second operand used for the output operation
e Input 3: represents the second operand used for the output operation
e Input 4: represents the second operand used for the output operation
NO contact position in alarm:
e Open: alarm output is closed under regular working conditions, and it opens in case of alarm
e Closed: alarm output is open under regular working conditions, and it closes in case of alarm
Low Set:
input value below which the alarm is triggered (in Low, Window)
Low Hysteresis:
hysteresis on the low set value
High Set:
Input value above which the alarm is triggered
High Hysteresis:
hysteresis on the high set value
On Delay:

time for which the input has to be in alarm condition before the alarm output is triggered, configurable from 0 to 1000
seconds in steps of 100 ms

Off Delay:

time for which the input has to be in normal condition before the alarm output is deactivated, configurable from 0 to 1000
seconds in steps of 100 ms.

FAULT:
alarm is triggered when input is out of configured range
In case of fault:

e Ignore: alarm is not affected
e Lock status: remains in the same status as it was before fault occurred
e Alarm active: alarm is triggered

e Alarm inactive: alarm is deactivated
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3.12.2 Monitor
The SWC5090 is able to continuously scan the module and display real-time values on screen.
Note that while the module is being monitored, configuration screens are disabled.

Bl G.M. Intemational - SWC5080 Configuration Software - D5212Q - * = X
File Settings Module 7 Store to device Load from device
Configuration MDI’"‘DT Data logger
Measured values [uA] Virtual outputs [pA] Outputs faults Alam Status
0
Input 1 Qutput 1 0 IN1 Out of range .
Input 2 0 Output 2 0 T IN2 Out of range
Input 3 ] Output 3 0 = IN3 Out of range
Input 4 1] Output 4 0 IN4 Qut of range
Monitored values
@ Input 1 Db212Q — Input 1
O lnput 2 240004
O Input 3 220004
O Input 4 20000+
O Output 1 18000+
O Output 2 16000
O Output 3 < 140004
O Output 4 S 12000
= 10000
Chart settings
8000
6000+
4000
2000
0 T T T T T 1
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Time [g]
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Figure 61: D5212Q / D6212Q Monitor screen.

The display shows Input and Theoretical Output values, fault and alarm status and a graph of chosen variable.

3.12.2.1 Input
This value represents the value read from field.

3.12.2.2 Output
This value represents the theoretical output value.

3.12.2.3 Alarm status
Alarm status is represented by a LED, which is RED when activated.
The LED status reflects the status of the Alarm exactly as configured.

3.12.2.4 Fault
Fault status is represented by a LED, which is RED when activated.

3.12.2.5 Graph
The graph can show only one variable that must be chosen from the checkboxes above.

3.12.3 Data Logger
The SWC5090 can monitor and record data from the module at constant configurable time intervals.
By changing the parameters, the user can decide the duration of the recording period and the frequency of readings.
After pressing “Start” button, the SWC5090 will prompt for a filename where the values will be stored in .CSV format.
Note that while the module is being recorded, Configuration screens are disabled, while Monitoring remains active.
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Figure 62: Data Logger screen.

3.13 5700
5700 is HART® Multiplexer Modem.

3.13.1 Configuration

To configure 5700 module, connect the device to PC through PPC5092, then click on “Load from device” button.

Il G.M. International - SWC5080 Configuration Software - Hart mux 5700 -
File Settings Module 7

Store to device

- X

Load from device

| Parameters |

Device parameters

Configuration parameters

Polling Address - 1 ~
Baud Rate 38400 s
GMI MESSAGE

GMI DESCRIPTOR
GMI LONGTAG

26

2017

|Data Editing

1

Command 1

2

2

2017 May 30 - 10:47:28

Figure 63: 5700 Parameters screen.

The only user configurable parameters are:
¢ Polling address: device address (from 0 to 62)
¢ Baud rate: data transmission speed (from 1200 to 115200 bit/s)

¢ Tag: identification of the specific module (maximum 8 alphanumerical characters)

4. Monitor

The SWC5090 is able to continuously scan the module and display real-time values on screen.
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A graph of the chosen variable (Input or Output) can also be displayed.
Please refer to modules specific chapters for more details on this feature.

5. Data Logger

The SWC5090 can monitor and record data from them module at constant time intervals.
Data is stored on a Comma Separated Value file (.CSV).
Please refer to modules specific chapters for more details on this feature.

6. Configuration File

Each time the main User Interface window is closed, a configuration file (SWC5090.ini) is saved in the installation
directory. The configuration file contains the last COM port used for the configuration and other parameters related to the

software.

7. Report sheet

The SWC5090 can print the full configuration set in A4 format. Below an example configuration report.

AL Configuration Report AL Configuration Report
Model: D52738\D6273S  Serial: ..cocvcvvcines Date: 2017 May 29 Model: D52738\D6273S  Serial: ..cocvcvvcines Date: 2017 May 29
Input 1 Input 1
Tag Chanrel 1 Tag Chanrel 1
Sensor Connection TC Sensor Connection TC
Sensor Type TCJ Sensor Type TCJ
Downscale (*C) 00 Downscale (*C) 00
Upscala (°C) 10000 Upscala (°C) 10000
Cald Junclion Source Aufornatic Cald Junclion Source Aufornatic
Cold Junchon Reference (°C) 0.0 Cold Junchon Reference (°C) 0.0
Integration Spesad slow Integration Spesad slow
Wains Frequancy 50 Hz Wains Frequancy 50 Hz
Offset_ o Offset_ o
Muliplier 1 Muliplier 1
Output 1 Output 1
Funchon Input 1 Funchon Input 1
Type 4-20 m& Source Type 4-20 m& Source
Downscale (&) 4000 Downscale (&) 4000
Upscale (uA) 20000 Upscale (uA) 20000
Under Range [LA] 3600 Under Range [LA] 3600
Over Range (UA) 20300 Over Range (UA) 20300
Faull Qutput Value 22000 Faull Qutput Value 22000
Faults Faults
Bumaout Active Bumaout Active
Internal Fault Inachve Internal Fault Inachve
Sensor Out Of Range Inachve Sensor Out Of Range Inachve
Out Saturabion Inachve Out Saturabion Inachve
Wadule Out Of Temperature Range Inachve Wadule Out Of Temperature Range Inachve

8. Installation and quick start
After having checked the requirements at Section 1.2, it is possible to proceed with the installation.

Figure 64: Configuration Report example.
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8.1 Installing the PPC5092 USB-to-MiniUSB Adapter driver
To install the adapter the user has the choice between:
e running the PPC5092.exe file located in the SWC5090 drivers directory;
e clicking on the “Install PPC5092” link in the “Programs Menu/SWC5090” directory;
e clicking on “Install PPC5092 drivers” voice inside the “?” menu in the SWC5090 software.
Please install PPC5092 drivers before inserting the adapter into an USB port of the PC.
After the installation has completed, insert the adapter in any available USB port.

8.2 Installing the SWC5090 Configuration Software

In case a previous version of the SWC5090 Configuration Software was installed on the system, it is preferable to
uninstall it before continuing.

Launch the installer Setup.exe and follow the instructions.
An icon (SWC5090) will be added to the program startup menu and to the Desktop at the end of the process.
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